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3skeng - Starting Guide 

To use 3skeng tools and libraries for SketchUp on your computer, you may follow 

the whole guide or just jump to topics of interest by clicking on a title below! 
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1) Download 3skeng 

 

Go to www.3skeng.com and browse to the download section. 

 

Download Ruby file for the installation of the 3skeng extension in SketchUp for both MAC OS and 

Windows OS. 

  

http://www.3skeng.com/
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2) Installation of 3skeng 

 

Installation of 3skeng by Ruby file for SketchUp 2020/2019/2018/2017 

- IMPORTANT: 

  Login on your computer as the user (account) who will use SketchUp with 3skeng! 

- Select Window > Extension Manager 

   The Extension Manager dialog box is displayed. 

- Click on Install Extensions (see screenshot). The Open dialog box is displayed. 

- Locate the Ruby zip file to install (3skeng_xxxx.rbz). 

- Click on the Open button. 

- After the installer completes, quit and restart SketchUp. 

 

 

 

- Open the “Extension Manager” dialogue box again. 

- Make sure that “3skeng Engineering 20xx” can now be found in the list of extensions 

  and the button is set to “Enabled”. 
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3) Request activation key for 3skeng 

 

a) Open SketchUp and click on the 3skeng symbol in the 3skeng toolbar. 

 

b) The 3skeng activation window opens. 

 

 
 

c) Please enter your email-address: 

Current/Registered users: 

Enter the same e-mail that you used previously for 3skeng activations & purchases (already user). 

In case you forgot: The address can be found by opening a previous version of SketchUp where an 

earlier version of 3skeng was installed. Click on the 3skeng symbol in the 3skeng tool palette. The 

email address that was used to previously register 3skeng will be displayed. 

New users: 

Enter an e-mail you have access to and want to use as the future user (new user). 

 

d) Select if you are already a 3skeng user or a new user.  

e) Fill out the short survey on the right with your main usage for 3skeng, your country (required) 

and your industry. 

f) Click on “get activation code”. 

g) Do not close the activation window.  
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4) Activation of 3skeng 

 

An activation key (one-time use) will be sent to the specified email address.  

 

 
 

If you do not get an email, make sure the email address is correct and check your junk email folder! 

   
 

a) Enter the activation code from the email in the appropriate field. 

b) Click on “activate…”. 

c) Allow 3skeng to download required files. Please have a little patience for this process... 

d) Restart SketchUp when prompted. 

e) Allow 3skeng to generate your local database after the restart of SketchUp.  
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5) Explanation of the client tab “my 3skeng” 

 

The 3skeng client tab “my 3skeng” (see screenshot) gives you an overview of your account: 

 
 

my 3skeng account 

Account: shows the account holder (e-mail address) that is currently activated. 

Version:  shows the 3skeng version that is currently installed. 

 

 

my 3skeng tools 

The latest 3skeng version (e.g. 3skeng 2019) requires tool upgrades in case you own tool licenses of 

any previous 3skeng version (e.g. 3skeng 2017). 

The current tool status is indicated by different symbols. The calendar symbol means that the tool is 

a trial version and requires an upgrade after the expiration of the trial time. 

Clicking on “manage tools…” allows you to add (purchase) new or upgrade licenses for the tools. 

 

 

my 3skeng libraries 

Libraries for the “Pipe” and “Mount” tool with remaining use time are available for all tool versions. 

They only require an extension in case they are expired. 

Clicking on “manage libraries …” allows you to add (purchase) libraries. 
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6) Add tools (purchase) 

 

Go to "manage tools" in the 3skeng client window tab “my 3skeng” (see screenshot) to access the 

purchase window for tools and tool upgrades. Click on “Buy now…” to start the purchase process of 

a tool. You can pay by PayPal or credit card (American Express, JCB, MasterCard and VISA). 

 

Depending on your home country and security settings of your credit card, 3skeng purchases by 

credit card may be declined by your credit card company. You can temporarily unlock international 

transactions and allow specific countries on request (Germany for 3skeng purchases). Please contact 

your credit card company or issuing bank in such cases.  

 

 

 

Learn more about the 3skeng license terms for tools and libraries here: 

http://www.3skeng.com/3s-products/License3skengEn.htm  
 

  

http://www.3skeng.com/3s-products/License3skengEn.htm
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7) Add detail libraries (Purchase) 

 

To get an overview of the available libraries, please open the 3skeng client tab “my 3skeng” and 

click on “manage libraries”. Every tab contains the available libraries of the correspondent material. 

There is a pdf-file with the library elements (content) for every library. First click on “[…more…]” and 

then on “here” to open the pdf-file of the library. 

 

 
 

To add a library, open the 3skeng client tab “my 3skeng” click on “manage libraries” and click on 

“Buy now” to purchase a detail library. 
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8) How to buy  

 

A) Use the integrated shop of the 3skeng software 

You can buy in the integrated shop after installation and activation (please see picture below). We 

accept the payments methods PayPal, Credit Card (AMEX, JCB, MasterCard and VISA) and 

prepayment by bank transfer. 

Your purchased license is directly added to your account after successful payment and you receive 

an invoice of the purchase (You will not receive a transaction key). The license can be used after 

synchronization of 3skeng and restart of SketchUp. With prepayment by bank transfer, you will 

receive license and invoice only after the money arrived in our account. 

 

Good-to-know: We work with approved third party payment solution providers. During the 

purchase process, you are rerouted to the provider's encrypted SSL-page resulting in 3skeng/SHK 

having no contact with your payment data (e.g. credit card data) at any time whatsoever. 

What can I do in case of Credit Card transaction errors? 

The most common reason is that your Credit Card company declines international transactions by 

default. In such a case, please contact your credit card company or issuing bank to (temporarily) 

unlock Germany for your 3skeng purchase(s). 

 

 

 

B) Buy 3skeng by invoice 

In case you need multiple licenses for your seat and / or seats with multiple licenses for multiple 

users, we can prepare a custom quotation for you and send an invoice after you decide to buy 

(Payable by PayPal, Credit Card (AMEX, JCB, MasterCard and VISA) and bank transfer.) 

Your purchased license(s) will be delivered by license card with transaction key.  

Please contact sales@3skeng.com with your requirements or information request and we will take 

care of you. 

 

C) Buy 3skeng through resellers 

Browse to our website www.3skeng.com and go to “download -> buy 3skeng” where we provide a 

map with our resellers. Your purchased license(s) will be delivered by license card with transaction 

key.  

mailto:sales@3skeng.com?Subject=Quotation%20request%20for%203skeng%20licenses
http://www.3skeng.com/
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9) How to use a transaction key 

 

Purchases through 3skeng by invoice and resellers are handed over by a personal transaction key 

(for one time use only). 

 

a) Go to "manage account" in the 3skeng client window tab “my 3skeng”. 

 

b) Type in your transaction key. 

 

c) Click on button “Activate transaction key and synchronize the database”. 

 

d) Your purchased 3skeng license(s) are added to your account (registered e-mail address) in the 

process. 

 

e) The transaction key is for one time use only and turns invalid after its activation in step d). 
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10) How to learn to use 3skeng  

 

3skeng was designed to follow the easy and intuitive use of SketchUp and at the same time provide 

powerful and useful functionality. 

 

To bring you up to speed with what you can do with 3skeng tools, we provide learning files in 

SketchUp format. 

 

The files guide you through the available functions of the tools scene by scene.  

You are asked to use specific values and angles to allow you to compare your result with the 

specified result at the end. 

 

Pdf-files that contain the scene descriptions in case you have trouble to read the texts on your 

screen are also available for download. 

 

We recommend to use the given file order and just skip tools (files) you are not interested in.  

 

Click the following links to download the individual files or an archive that contains all files: 

 

Learn to use (1.1) 3skeng Pipe conceptual (skp) 

Learn to use (1.1) 3skeng Pipe conceptual (pdf with scene text) 

Learn to use (1.2) 3skeng Pipe detail basics (skp) 

Learn to use (1.2) 3skeng Pipe detail basics (pdf with scene text) 

Learn to use (1.3) 3skeng Pipe detail advanced (skp) 

Learn to use (1.3) 3skeng Pipe detail advanced (pdf with scene text) 

 

Learn to use (2.1) 3skeng Mount basics (skp) 

Learn to use (2.1) 3skeng Mount basics (pdf with scene text) 

Learn to use (2.2) 3skeng Mount advanced (skp) 

Learn to use (2.2) 3skeng Mount advanced (pdf with scene text) 

 

Learn to use (3.1) 3skeng Steelwork basics (skp) 

Learn to use (3.1) 3skeng Steelwork basics (pdf with scene text) 

Learn to use (3.2) 3skeng Steelwork advanced (skp) 

Learn to use (3.2) 3skeng Steelwork advanced (pdf with scene text) 

 

Learn to use (4) 3skeng Channel (skp) 

Learn to use (4) 3skeng Channel (pdf with scene text) 

 

Learn to use (5) 3skeng compatible Components (skp) 

Learn to use (5) 3skeng compatible Components (pdf with scene text) 

 

Learn to use 3skeng (1)-(5).zip (skp’s & pdf’s with scene text) 

 

Learning files for previous 3skeng 2018/2017/2016/2014 versions: 

Learn to use 3skeng (1)-(7).zip (skp’s & pdf’s with scene text)  

http://www.3skeng.com/download/Learn-to-use-(1.1)-3skeng-Pipe-conceptual_ver.2.1.skp
http://www.3skeng.com/download/Learn-to-use-(1.1)-3skeng-Pipe-conceptual_ver.2.1.pdf
http://www.3skeng.com/download/Learn-to-use-(1.2)-3skeng-Pipe-detail-basics_ver.2.0.skp
http://www.3skeng.com/download/Learn-to-use-(1.2)-3skeng-Pipe-detail-basics_ver.2.0.pdf
http://www.3skeng.com/download/Learn-to-use-(1.3)-3skeng-Pipe-detail-advanced_ver.2.0.skp
http://www.3skeng.com/download/Learn-to-use-(1.3)-3skeng-Pipe-detail-advanced_ver.2.0.pdf
http://www.3skeng.com/download/Learn-to-use-(2.1)-3skeng-Mount-basics_ver.2.0.skp
http://www.3skeng.com/download/Learn-to-use-(2.1)-3skeng-Mount-basics_ver.2.0.pdf
http://www.3skeng.com/download/Learn-to-use-(2.2)-3skeng-Mount-advanced_ver.2.0.skp
http://www.3skeng.com/download/Learn-to-use-(2.2)-3skeng-Mount-advanced_ver.2.0.pdf
http://www.3skeng.com/download/Learn-to-use-(3.1)-3skeng-Steelwork-basics_ver.2.0.skp
http://www.3skeng.com/download/Learn-to-use-(3.1)-3skeng-Steelwork-basics_ver.2.0.pdf
http://www.3skeng.com/download/Learn-to-use-(3.2)-3skeng-Steelwork-advanced_ver.2.0.skp
http://www.3skeng.com/download/Learn-to-use-(3.2)-3skeng-Steelwork-advanced_ver.2.0.pdf
http://www.3skeng.com/download/Learn-to-use-(4)-3skeng-Channel_ver.2.0.skp
http://www.3skeng.com/download/Learn-to-use-(4)-3skeng-Channel_ver.2.0.pdf
http://www.3skeng.com/download/Learn-to-use-(5)-3skeng-compatible-Components_ver.2.0.skp
http://www.3skeng.com/download/Learn-to-use-(5)-3skeng-compatible-Components_ver.2.0.pdf
http://www.3skeng.com/download/Learn-to-use-(1)-(5)-3skeng_ver.2.0.zip
http://www.3skeng.com/download/Learn-to-use-(1)-(7)-3skeng_ver.1.1.zip
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11) 3skeng compatible elements / equipment / facilities / components 

 

The available libraries includes selected standard parts for piping, tubing and ductwork. 

There are many manufacturers for many different applications (e.g. pumps, fans, air handling units, 

valves, dampers, etc.) available on the market. So we are well aware that we cannot fulfill our 

users’ expectations concerning library content (e.g. valve types and sizes) and nature of available 

libraries (e.g. no air handling unit library). 

 

So we decided to provide a solution / workflow to make your own parts, equipment, facilities and 

components (e.g. drawn by yourself, 3D warehouse, etc.) compatible to 3skeng functions. 

We recommend that you set up your own SketchUp library file(s) that includes all the customized 

elements you need in your daily workflow. 

 

The parts, equipment, facilities and components you create won’t become a part of a 3skeng library 

directly but 3skeng recognizes integrated reference points and will select the appropriate pipe or 

connectors (e.g. Flange, VCR-f, etc.) for line attachment and can also work with the functions 

edit/rotate and connect (e.g. facility / utility connections of an air handling unit). 

 

You just have to consider that the right-click function “select line/all connected” doesn’t select these 

3skeng-compatible parts as part of the line (if you don’t right-click after selecting on all them). This 

is because this “3skeng compatible component” function can also be used for machines with 

connections of different utilities and we don’t want to select all lines with different pipe materials and 

different utilities. 

 

The fastest way to make a component compatible to the 3skeng tools is simply to add appropriate 

3skeng elements (e.g. flange) or pieces of pipe in that component.  

 

Learn more in chapter 10 where you can get a learning file that guides you through the process of 

making 3skeng compatible components. 
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12) Answers for the most frequent questions 

 

3skeng freezes for a longer period of time during some situation / operations? 

Please minimize the trays “Components” and “Outliner” as they requires lots of computing power 

and may lead 3skeng (and other extensions) to freeze! 

 

 

 

 

 

How can I get my 3skeng licenses up and running again in case I have a new computer or 

new SketchUp version or new 3skeng version? 

Please follow the guide starting from chapter 1 and following. 

Please consider: It is very important that you use the same email address that you used for initial 

activation and purchases to continue using your licenses! 

 

 

I have problems with my libraries for some reason (e.g. interrupted or defective 

download). How can I force 3skeng to synchronize the content? 

Please click on the menu:  

“Extensions \ 3skeng Engineering 20xx \ maintenance \ Check for update… …”. 

That will trigger 3skeng to synchronize your installation. When prompted, please restart SketchUp 

and allow it to rebuild the local database. 

 

 

How can I use another e-mail address (account) for my 3skeng installation? 

Please click on the menu: 

“Extensions \ 3skeng Engineering 20xx \ maintenance \ Reset local Database…”.  

That will reset 3skeng and require a new 3skeng activation (please see chapter 4 of that guide). You 

can enter another e-mail address at that step. 
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13) How to deactivate and / or uninstall 3skeng 

 

Deactivate 3skeng  

To deactivate 3skeng, untag it in: 

MAC OS: “View -> Tool Palettes” (dropdown menu).  

Windows OS: “View -> Toolbars…” 

 

        

 

 

 

 

 

 

 

 

 

 

 

Uninstall 3skeng 

Please deactivate 3skeng (see above), close SketchUp and manually delete the following: 

 

Delete “3skeng 2020” database folder: 

C:\Users\%username%\AppData\Roaming\3skeng_V2020\Sketchup 201x 

 

Delete “3skeng 2019” database folder: 

C:\Users\%username%\AppData\Roaming\3skeng_V2019\Sketchup 201x 

 

Delete “3skeng 2018” database folder: 

C:\Users\%username%\AppData\Roaming\3skeng_V2018\Sketchup 201x 

 

Delete “3skeng 2017” database folder: 

C:\Users\%username%\AppData\Roaming\3skeng_V2017\Sketchup 201x 

 

Delete “3skeng 2016” database folder: 

C:\Users\%username%\AppData\Roaming\3skeng_V2016\Sketchup 201x 

 

Delete 3skeng Plugin program folder: 

In Path C:\Users\%username%\AppData\Roaming\SketchUp\SketchUp 2020\SketchUp\Plugins 

Delete folder “\shk_3skeng\” and file “shk_3skeng.rb” 

In Path C:\Users\%username%\AppData\Roaming\SketchUp\SketchUp 2019\SketchUp\Plugins 

Delete folder “\shk_3skeng\” and file “shk_3skeng.rb” 

In Path C:\Users\%username%\AppData\Roaming\SketchUp\SketchUp 2018\SketchUp\Plugins 

Delete folder “\shk_3skeng\” and file “shk_3skeng.rb” 

In Path C:\Users\%username%\AppData\Roaming\SketchUp\SketchUp 2017\SketchUp\Plugins 

Delete folder “\shk_3skeng\” and file “shk_3skeng_extension.rb” 

In Path C:\Users\%username%\AppData\Roaming\SketchUp\SketchUp 2016\SketchUp\Plugins 

Delete folder “\shk_3skeng\” and file “shk_3skeng_extension.rb” 


